CHAPTER

Working with the Cisco Prime Network Vision
Client

The following topics describe the user access roles required to use Cisco Prime Network Vision (Prime
Network Vision), the Prime Network Vision working environment, and how to access the Prime Network
Vision tools and commands:

e User Roles Required to Work with Prime Network Vision, page 2-1
e Launching Prime Network Vision, page 2-2

e Prime Network Vision Window, page 2-4

e Prime Network Vision Status Indicators, page 2-24

e Prime Network Vision Toolbar, page 2-29

¢ Prime Network Vision Menu Bar, page 2-31

e Prime Network Vision Right-Click Menus, page 2-37

e Changing a User Password in Prime Network Vision, page 2-47

¢ Selecting Prime Network Vision Options, page 2-47

e Working with Prime Network Tables, page 2-49

User Roles Required to Work with Prime Network Vision

Table 2-1 identifies the GUI default permission or device scope security level that is required to work
with Prime Network Vision. Prime Network Vision determines whether you are authorized to perform a
task as follows:

e For GUI-based tasks (tasks that do not affect devices), authorization is based on the default
permission that is assigned to your user account.

¢ For element-based tasks (tasks that do affect elements), authorization is based on the default
permission that is assigned to your account. That is, whether the element is in one of your assigned
scopes and whether you meet the minimum security level for that scope.

For more information on user authorization, see the Cisco Prime Network 3.9 Administrator Guide.

By default, users with the Administrator role have access to all managed elements. To change the
Administrator user scope, see the topic on device scopes in the Cisco Prime Network 3.9 Administrator
Guide.
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Table 2-1 Default Permission/Security Level Required for Prime Network Vision Functions
Task Viewer Operator |OperatorPlus  |Configurator Administrator
Start Prime Network X X X X X

Vision

Change a user password |—! —! —! —! X!

in Prime Network

Vision

Set Prime Network X X X X X

Vision options

Work with Prime X X X X X
Network Vision tables

1. Each user can change their own password, but only the Administrator role can change another user’s password.

Launching Prime Network Vision

Note

Prime Network provides two methods for launching Prime Network Vision:
¢ From the Cisco Prime Central portal
e As a standalone application

Prime Network Vision is password protected to ensure security. Before you start working with Prime
Network Vision, make sure you know your username and password. If you use the standalone
application, you also need to know the Prime Network Vision gateway IP address or hostname.

If you do not log into Prime Network Administration, Prime Network Vision, or Prime Network Events
during a specified period of time (the default is one month) from the standalone application, your
account is automatically locked. The default period can be changed per user in Prime Network
Administration. The period of time is measured from the time you last logged out of any of the Prime
Network client applications. For more information about changing the default period and unlocking an
account, see the Cisco Prime Network 3.9 Administrator Guide.

The following topics describe how to launch Prime Network Vision:
e Launching Prime Network Vision from Prime Central, page 2-2

e Launching Prime Network Vision as a Standalone Application, page 2-3

Launching Prime Network Vision from Prime Central

If Prime Central is available in your environment, you can launch Prime Network applications from the
main Prime Central page.

To launch Prime Network Vision from Prime Central, choose Assure > Prime Network > Vision in the
menu bar.

The Prime Network Vision application is opened in a separate window.

] Cisco Prime Network 3.9 User Guide
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For more information about using Prime Network Vision with the Prime Central suite of products, see:
e Cisco Prime Central 1.0 User Guide
e Prime Network Vision Right-Click Menus, page 2-37

Launching Prime Network Vision as a Standalone Application

Step 1

Step 2

Step 3

To launch Prime Network Vision as a standalone application:

Choose Start > Programs > Cisco Prime Network > gateway hostname/IP address > Cisco Prime
Network Vision.

~

Note  The hostname/IP address corresponds to the gateway on which Prime Network was configured.

The Cisco Prime Network Vision login dialog box is displayed.
Enter your username and password.

The Server field should already be populated with the hostname/IP address of the Prime Network
gateway.

Click OK.
If any client updates are available, Prime Network automatically installs them.

When you launch Prime Network Vision, messages are displayed if the server and client have different
versions of the application that launches the client. For more information about these messages, see the
Cisco Prime Network 3.9 Installation Guide.

The Prime Network Vision window appears empty when it is opened for the first time. You can create a
new map or open a map that has been previously saved; see Chapter 4, “Working with Prime Network
Vision Maps,” for information on network maps. You can also open inventory tabs such as the Network
Elements tab, which provides the available network element inventory. For more information on
inventory tabs, see Prime Network Vision Inventory Tabs, page 2-5.

After logging into Prime Network Vision and launching the application, you can customize the Prime
Network Vision settings. For example, you can:

e Load the content pane with information when starting Prime Network Vision.

e Display network elements in the Prime Network Vision content pane and navigation pane.
¢ Configure audio responses when different alarms are triggered.

e Specify the length of time that events should be displayed in the inventory window.

For more information on customizing Prime Network Vision startup and display options, see Selecting
Prime Network Vision Options, page 2-47.
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Prime Network Vision Window

Figure 2-1 displays the Prime Network Vision window with an open map.
Figure 2-1 Prime Network Vision Window
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The Prime Network Vision window can display either inventory tabs or maps. For more information, see
the following topics:

e Prime Network Vision Inventory Tabs, page 2-5

e Prime Network Vision Maps, page 2-7
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The Prime Network Vision window enables you to:
e View network element inventory.
e View maps.
e Display network element properties.
¢ Link to element physical and logical inventory information.
e View complete or filtered lists of links in a map and link status.
e View link properties.

e View and manage tickets.

o

The ticket pane can be displayed or hidden by clicking the arrows below the navigation pane (see Callout
7 in Figure 2-1).

The status bar at the bottom of the window provides information about the current connection status for
the view. The status bar also displays information about the command that was sent while the application
waits for an answer.

The memory utilization bar in the status bar displays the amount of memory used by the client. By
default, if memory utilization exceeds 60%, it is colored yellow, and if it exceeds 80%, it is colored red.

Dragging the borders of the Prime Network Vision window adjusts the size of each pane. The navigation
pane and content pane are correlated; this means that selecting an option in the navigation pane affects
the information displayed in the content pane.

Prime Network Vision Inventory Tabs

The Prime Network Vision interface includes inventory tabs that enable you to access many Prime
Network Vision features and functions without opening a map. For example, by opening the Network
Elements inventory tab, you can:

e View the available network element inventory, including an element’s:
— VNE communication and investigation states.

— Severity status and whether any tickets that are not cleared or acknowledged are associated with
the element.

— Logical or physical inventory.
— Tickets and events, with the ability to clear, acknowledge, or clear and remove tickets.
e Identify and open maps that contain a selected element.
e Search and filter the network element inventory for elements that meet your specific criteria.
Prime Network Vision includes the following inventory tabs:

e Network Elements—Lists all network elements with the information described in Table 2-8,
Network Element Information Displayed in List View, and the following two columns:

— Severity—Displays an icon that indicates the highest severity ticket associated with the element.

— Unacknowledged—Displays a severity icon that indicates the severity of the highest severity
ticket associated with the element that is not acknowledged.

Cisco Prime Network 3.9 User Guide
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e Ethernet Flow Domains—Lists all Ethernet flow domains, including the domain name, the
system-defined domain name, and a brief description for each domain. For more information about
Ethernet flow domains, see Viewing and Renaming Ethernet Flow Domains, page 12-39.

¢ VTP Domains—Lists all VTP domains. For more information about VTP domains, see Viewing
VLAN Trunk Group Properties, page 12-65.

Opening Inventory Tabs

To open an inventory tab, either click the Network Elements icon in the toolbar or choose Network
Elements in the menu bar, and choose the required option.

The selected inventory table is displayed as shown in Figure 2-2.

Figure 2-2 Prime Network Vision Inventory Tabs
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The inventory tabs display the network inventory icon and name. If a tab is selected, it also displays an
X for closing the tab. To close a tab that is not selected, place your cursor over that tab and click the X
once it appears.
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Working with Inventory Tabs

Table 2-2 describes the functions that are available for working with inventory tabs.

Table 2-2 Working with Inventory Tabs
Function Description
Filter Click Filter in the table toolbar and specify filter criteria.

For more information, see Filtering Table Contents, page 2-53.

Scroll If the number of entries exceeds the current viewing area, use your mouse
scroll wheel to move up and down through the table.

Search This option is available only for the Network Elements tab.
To search for specific elements:

1. Click Search.

2. In the drop-down list, select the category to search.

3. In the search field, enter the string to search for.

4. Click Go.

Sort To sort:

e By asingle column, click the column heading. Click the heading again
to sort in the reverse order.

e Using multiple sort criteria, click Sort Table Values in the toolbar and
select the required criteria.

For more information, see Sorting a Table, page 2-51.

Prime Network Vision Maps

Prime Network Vision enables you to visualize networks through network and service maps. These maps
provide access to element physical and logical inventories, connectivity, and the current network and
service states.

You can create as many maps as required to represent the network views you need. For example, maps
can include specific network segments, customer networks, or the particular network elements and
services that you require.

Each map is displayed in a tab that contains the following panes (as shown in Figure 2-1):

e Navigation pane—Tree-and-branch representation of the network elements and aggregations in the
current map. For more information, see Navigation Pane, page 2-9.

¢ Content pane—Representation of map elements and links in a map (topological layout) or in list
format. For more information, see Content Pane: Map, List, and Links Views, page 2-10.

¢ Ticket pane—Tickets associated with elements currently displayed in the map and ticket status. For
more information, see Ticket Pane, page 2-24.

Cisco Prime Network 3.9 User Guide
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Opening Maps

You can open an existing map in any of the following ways:
e In the menu bar, choose File > Open Map.
¢ In the toolbar, click Open Map.
¢ In the Network Elements tab, right-click the required element and choose Open Relevant Maps.

¢ In either the navigation pane or content pane, right-click the required element and choose Open
Relevant Maps.

The Open Map dialog box is displayed (see Figure 2-3).

Figure 2-3 Open Map Dialog Box
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Depending on the method you use to open this dialog box, the Open Map dialog box lists either all maps
or only those maps that contain the selected network element.

A check mark in the Opened column indicates that the map is already open.
Select the required maps and click OK.
Map tabs display the root node icon and name.

In addition, the icon color reflects the highest severity ticket that is not cleared in the map, and an alarm
icon indicates the severity of the highest severity ticket that is not acknowledged. If a tab is selected, it
also displays an X for closing the tab. To close a tab that is not selected, place your cursor over that tab
and click the X once it appears.

Cisco Prime Network 3.9 User Guide
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For more information about maps, see Working with Prime Network Vision Maps, page 4-1.

Working with Multiple Tabs

Prime Network Vision enables you to open up to eight tabs at a time:
e One each of the three inventory tabs
e Up to five maps, each with their own tab
The following features can help you navigate multiple tabs more quickly:
e Use the following keyboard shortcuts to move between tabs:
— Ctrl+Tab—Moves to the next tab to the right.
— Ctrl+Shift+Tab—Moves to the next tab to the left.
e Ifaname is cropped in atab, hover your cursor over the tab to view a tooltip with the complete name.

e If the number of tabs exceeds the window width, use the scroll arrows to the right of the tabs to move
through the tabs.

e To view all tabs that are open and optionally select one, click Window in the menu bar and choose
the required tab.

Navigation Pane

The navigation pane displays a tree-and-branch representation of the network elements and aggregations
defined for the loaded map.

The highest level in the navigation tree displays root node icon with the map name. When the map name
is changed, the Prime Network Vision window is updated, and the new map name is displayed at the top
of the navigation tree and in the window title bar.

The lowest level of the navigation tree displays a single network element or service, such as a port,
Ethernet flow point, or bridge.

The navigation pane can include up to two icons for each element. These icons can include alarm icons,
communication or investigation state icons, and badges, as shown in Figure 2-4. Alarm icons are always
displayed next to the element icon.

Figure 2-4 Navigation Pane with Icons
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For information about the status of network objects, see Prime Network Vision Status Indicators,
page 2-24.

Cisco Prime Network 3.9 User Guide
| oL-26486-01 .m



Chapter2  Working with the Cisco Prime Network Vision Client |

B Prime Network Vision Window

Content Pane: Map, List, and Links Views

The content pane enables you to view and modify low-level information. It supports the following views:

e Map view—Displays managed network elements on a geographical map. For more information, see
Map View, page 2-10.

e List view—Displays the details of the network elements contained in the currently selected
hierarchy or subnetwork (map), such as the IP address and system name. For more information, see
List View, page 2-18.

e Links view—Displays a complete list of the links in the map view and their status. For more
information, see Links View, page 2-22.

When you switch between the map, list, and links views, the following are preserved:
e The currently selected network elements or links.
e The sorting preferences.
¢ The filtering preferences, as defined using:
— The Link Filter dialog box—See Filtering Links in a Map, page 4-38.
— The Filter dialog box—See Filtering Table Contents, page 2-53.

— The links view collection method—See Filtering Links Using the Collection Method,
page 5-18.

Map View

Click Show Map View on the toolbar to display the map view in the Prime Network Vision window.
In the map view, Prime Network Vision displays:

e Aggregations

e Managed network elements

- Each network element is displayed as an icon, the color of which reflects severity, as described
in Alarm Indicators, page 2-17.

— Depending on the size of the icon, additional information can be displayed. For more
information, see Information Available in Element Icons, page 3-3.

e FEthernet flow point cross-connects
¢ Ethernet services
e MPLS-TP tunnels

e Pseudowires

e VLANSs

e VPLS instances
e VPNs

e Links

— Service and business links are represented as well as physical and topological links.

— Unidirectional links include arrowheads that indicate the direction of the flow, while
bidirectional links do not have arrowheads.

e Relationships between network elements, aggregations, and networks

Cisco Prime Network 3.9 User Guide
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The map view enables you to view network objects down to the device level. An example of the map
view is displayed in Figure 2-1.

You can move network elements manually on the map by dragging the required icon. You can also click
Layout Map in the toolbar or use your mouse to change the way the elements are displayed on the map.
For more information about working with maps, see Chapter 4, “Working with Prime Network Vision
Maps.”

Element Icons

Prime Network Vision enables you to:
e Zoom in and out on maps with your mouse.
e Apply one of four icon sizes to icons.
e View more or less information about the element in the icon, depending on the icon size.
e Access common functions from the icons, such as attaching business tags or viewing properties.

Table 2-3 provides examples of the four icons sizes and describes the information that is available with

each.
Table 2-3 Prime Network Vision Element Icon Sizes
Example Icon Name and Description

Tiny

e Displays the element as a dot.

e Alarm severities are indicated by dot and link colors.

o Normal
23
A ¢ Displays the element as an icon with the element name below
\ o the icon.
SAREAET @ (2] e Alarm severities are indicated by badge, element icon

outline, and link colors.

WLANS [1M]
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Table 2-3 Prime Network Vision Element Icon Sizes (continued)
Example Icon Name and Description
Large

PE1-7204-As [2W]

: '__; Ci MVXR
1&.4{20)T

e Displays the element as a card with:

— Element name in the title bar

— Up to three additional properties

e Alarm severities are indicated by card outline, element icon
outline, and badge colors.

e Property text can be selected for cut-and-paste operations by
pressing and dragging the mouse scroll wheel over the text.

Huge
C9-AGG20 [16M+]

B MM Cisco ASR 9006
A4 %‘I 10.56.101.154 . .
@ ==& 401[Default] — Element name in the title bar

e Displays the element as a card with:

17}

— Up to four additional properties
— Up to four action buttons

e Alarm severities are indicated by card outline, element icon
outline, and badge colors.

e Property text can be selected for cut-and-paste operations by
pressing and dragging the mouse scroll wheel over the text.

For more information about using these features, see:
e Resizing Map Elements, page 4-14
¢ Information Available in Element Icons, page 3-3

Prime Network Vision also provides additional features for working with aggregations. For more
information, see Working with Aggregations, page 4-28.

The following tables identify some of the icons used to represent network elements and business
elements in the Prime Network Vision window’s navigation pane and content pane:

e Table 2-4, Prime Network Vision Network Element Icons
e Table 2-5, Prime Network Vision Business Element Icons

For a complete list of the icons and their descriptions, see Appendix A, “Icon and Button Reference.”

Cisco Prime Network 3.9 User Guide
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Icon

Network Element

[

Access pseudowire

Router

bed

ATM switch

Basic rate access (BRA)

Cisco 7600 series router

Cisco ASR 1000 series router

Cisco ASR 5000 series router

H E = R

Cisco ASR 9000 series router

B

b

Cisco CRS series router

gy

Cisco MWR 3941

Cisco Nexus 1000 series devices

i O

ki

Cisco IOS XR 12000 series router

i
=

Cisco Unified Computing System (UCS)

Cloud

W

Digital subscriber line access multiplexer (DSLAM)
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Table 2-4 Prime Network Vision Network Element Icons (continued)

Icon Network Element

=
+

Ethernet switch

Generic SNMP device

Ghost, or unknown device

—— ICMP device

& Lock, or security violation; viewable by a user with a higher permission level

Missing icon, displayed in either of the following situations:

2

e A device has been deleted via Cisco Prime Network Administration, but
remains in the map.

e A unique icon for an element (physical or logical) does not exist.

Sun Netra server

Service control switch

WiFi element

Note  When Prime Network Vision detects a network element for which it does not have enough information
available, Prime Network Vision displays as a ghost element on the map. When this occurs, you cannot
view the ghost element properties or communicate with it. When the information for the ghost element
becomes available, Prime Network Vision replaces its icon with the relevant element icon, and updates
the related element and communication information.

Table 2-5 Prime Network Vision Business Element Icons

Icon Business Element

r 3 Aggregation or root node
E
i -ﬂ1

P ; Backup pseudowire edge
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Table 2-5 Prime Network Vision Business Element Icons (continued)

Icon Business Element

Connection termination point (TP)
Ethernet flow point (EFP)

MToP service

EFP cross-connect

Ethernet service

BH &

Ethernet virtual connection (EVC)

Label-Switched Path (LSP) end point

&)

-
B‘l m
?
— L

LSP mid point

Missing icon, displayed in either of the following situations:

e A device has been deleted via Cisco Prime Network Administration, but
remains in the map.

e A unique icon for an element (physical or logical) does not exist.

Network LSP
E. Protected LSP
Working LSP
wly Network pseudowire
A T
b
ey '| Network Traffic Profile (TP) tunnel
E 6

Network VLAN

==l |Pseudowire edge

Pseudowire switching entity

il

t
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Table 2-5 Prime Network Vision Business Element Icons (continued)
Icon Business Element
Subnet

"I |Switching entity
++

TP tunnel endpoint

== |VPLS forward

ssa |VPLS instance

E VPN

Links

Prime Network Vision maps contain graphical links that can represent multiple physical, topological,
service, and business links.

The maximum number of graphical links that can be displayed is specified in the registry. If the number
of graphical links exceeds the specified limit, a warning message with a Refresh button is displayed, and
the map is surrounded by a red border. The presence of a red border around a map indicates that some
links exist that are not displayed in the map.

>
Note  Changes to the registry should only be carried out with the support of Cisco. For details, contact
your Cisco account representative.
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Step 1

Step 2

S

Note

Alarm Indicators

To reduce the number of graphical links in a map:

Remove the links in any of the following ways:

e Use the links view:

Prime Network Vision Window [l

a. Click Show Links View in the toolbar. The links view includes all links, even if the number of
links exceeds the number of graphical links that can be displayed in a map.

b. Filter the links so that the map contains only the required links. For more information on filtering

links, see Filtering Links in an Existing Map, page 4-40.

¢ Click Link Filter in the toolbar, uncheck the check boxes for the links you do not need to view, and
click OK.

Only the links selected appear in the map and the Link Filter icon in the toolbar changes to indicate
that a link filter is applied.

e Right-click linked devices and choose Remove from Map.

After you remove the links, click Refresh to refresh the map contents and to see if the red border has
been removed, indicating that all links are displayed in the map.

Links in maps have tooltips that provide you with information regarding the link endpoints and the
number of links represented by the selected link in the map. Click the link tooltip to view additional
information about the link in a link quick view window. Click Properties in the link quick view window
to open the link properties window. For more information about viewing link properties, see Viewing

Link Properties in Prime Network Vision Maps, page 5-4.

If you apply a link filter to the map, the link tooltip displays only the relevant links.

Table 2-6 shows the colors that are used to display the severity (or propagated severity) of a network
element in the navigation, content, and ticket panes.

Table 2-6 Severity Indicators
Icon Color Severity
o Red Critical
@ Orange Major
Yellow Minor
@ Light Blue Warning
Green Cleared, Normal, or OK

| oL-26486-01
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Table 2-6 Severity Indicators (continued)

Icon Color Severity

Medium Blue |Information

Dark blue Indeterminate

The same coloring conventions apply to the link severities displayed in the map view, links view, and
link quick view.

Note The color of a selected link can be customized. The default color is blue.

When you select an aggregation in the navigation tree, you can view the elements that belong to that

aggregation in the map pane by either double-clicking its icon or clicking the plus sign in the upper right
corner of its icon.

For more information about how the status of a network element is displayed in a map, see Prime
Network Vision Status Indicators, page 2-24.

Right-Click Functions

Many functions can be performed by using the right-click menu in the map view, including launching
external applications or tools. Some of these functions are also available in the navigation pane, links
view, and ticket pane.

The specific options that are available in the right-click menu depend on whether you select a network
element, click in the map background, select an aggregation, or select a ticket in the ticket pane. For
details on the specific right-click options that are available for each scenario, see Prime Network Vision
Right-Click Menus, page 2-37.

List View

Click Show List View in the toolbar to display the Prime Network Vision list view. The list view displays
the tabs described in Table 2-7, depending on the items included in the current map and the item selected
in the navigation tree.

Table 2-7 Prime Network Vision List View Tabs

Tab Description

Aggregations Aggregations in the current map.

Connection TP Connection termination points (TPs) in the current map.

EFP Cross-Connect |EFP cross-connects in the current map.

Ethernet Flow Points |EFPs in the current map.

Ethernet Services Ethernet services in the current map.

EVCs EVCs in the current map.

Network Elements Network elements in the current map that are in the user’s scope.

Network Pseudowire |Network pseudowires in the current map.

Cisco Prime Network 3.9 User Guide
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Table 2-7 Prime Network Vision List View Tabs (continued)

Tab Description

Network TP Tunnel |Network Traffic Profile (TP) tunnels in the current map.
Pseudowires Pseudowires in the current map.

Pseudowire Edge

Pseudowire endpoints in the current map.

PW Switching Entity

Pseudowire switching entities in the current map.

Restricted Elements

Network elements in the current map that are not in the user’s scope.

Sites

Sites for the selected VLAN. Site properties include site name, description,
location, and IP interface.

Switching Entities

Switching entities in the current map.

Virtual Routers

Virtual routers on the selected VLAN. Virtual router properties include the
virtual router name and description.

VLANSs

VLANS in the current map. VLAN properties include VLAN name,
identifier, description, and Ethernet flow points.

VPLS Forward

VPLS forwards in the current map.

VPLS Instance

VPLS instances in the current map.

VPNs

VPNs in the current map. VPN properties include VPN name and description

Table 2-8 describes the network element properties displayed in the Network Elements tab. (Locked
network elements display only managed element information and the locked element icon.) To ensure
that you are viewing the latest information, either perform a new search or click the Refresh button.

Table 2-8 Network Element Information Displayed in List View

Field Name Description

Name Name of the network element managed by Cisco, as defined in Cisco Prime
Network Administration. The Name property also displays a network
element icon. The icon color reflects the highest network element alarm
severity. In addition, the management state or an alarm icon is displayed.

IP Address [P address used for managing the network element.

System Name

System name of the network element, as defined in the network element's
MIB. If the network element is configured for Telnet access, the prompt is
displayed.

Severity

Current operational health of the network element.

Unacknowledged

Severity of the most severe unacknowledged ticket.

Communication State

Ability of the VNE to reach the network element, according to the health of
the element. For more information about communication states, see the
Cisco Prime Network 3.9 Administrator Guide.

Investigation State

Level of network element discovery that has been performed or is being
performed by the VNE. For more information about investigation states, see
the Cisco Prime Network 3.9 Administrator Guide.

Vendor

Vendor name.

Product

Network element category, such as Router or Eth-Switch (Ethernet switch).
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Table 2-8

Network Element Information Displayed in List View (continued)

Field Name

Description

Device Series

Device series, such as Cisco 7600 Series Routers.

Element Type

Cisco 7200.

Network element type including the manufacturer’s name, such as

Software Version

Cisco IOS software version running on the network element.

Location Location of the network element.
Up Since Date and time the network element was last reset.
Tip Click the red triangle in a cell to expand the cell and view all the information it contains. You can also

use a tooltip to view all the information.

Table 2-9 identifies the buttons that are displayed in the list view toolbar.

Table 2-9 List View Toolbar
Icon Name Description
Els Find Searches the table for the string you enter.

For more information, see Finding Text in a Table,
page 2-51.

Export to CSV

Exports the information displayed in the table, or
selected portions, to a CSV file.

For more information, see Exporting Tables to a
File, page 2-55

Sort Table Values

Sorts the information displayed in the table by the
criteria you specify.

For more information, see Sorting a Table,
page 2-51.

Filter

Filters the information displayed in the table by
the criteria you specify.

For more information, see Filtering Table
Contents, page 2-53.

Clear Filter

Clears the existing filter.

Show All Rows

Displays all table rows that meet the current
filtering criteria.

Show Only Selected
Rows

Displays only the rows that you select.

For more information, see Viewing Selected
Rows, page 2-54.
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See Working with Prime Network Tables, page 2-49 for more information about filtering, finding details
about a network element in Prime Network Vision tables, and keyboard shortcuts available for accessing
table functionality.

Table 2-10 describes some of the functions that are available from the right-click menu in the list view.
You must select an item for the right-click menu to appear. Not all options are available for all selections.

Table 2-10

List View Right-Click Options

Right-Click Option

Function

Related Documentation

Inventory View network element inventory Opening the Inventory Window,
page 3-12
Poll Now Poll the selected element
Attach / Detach / Edit Configure and view business tag information Chapter 6, “Working with Business Tags

Business Tag

and Business Elements”

Config Mgmnt

View the Configuration Management page in
Prime Network Change and Configuration
Management

Cisco Prime Network 3.9 Change and
Configuration Management User and
Administration Guide

Image Mgmnt

View the Image Management page in Prime
Network Change and Configuration Management

Cisco Prime Network 3.9 Change and
Configuration Management User and
Administration Guide

Run Report

Generate reports

Chapter 10, “Working with Reports”

Show Only Selected Rows /
Show All Rows

View selected rows or all rows

Viewing Selected Rows, page 2-54

Tools Ping or telnet a VNE, or check VNE CPU usage |List View Right-Click Menu, page 2-43
Topology Configure the topology Adding Static Links, page 5-15
Properties View network element properties Viewing the Properties of a Network
Element, page 3-5
Commands Launch any of the commands that are included Cisco Prime Network 3.9 Reference
with Prime Network Vision Guide
Management Access Command Builder and Soft Properties Cisco Prime Network 3.9 Customization
Management User Guide
VNE Tools Poll a VNE, or start or stop a VNE Updating VNE Information, page 3-12
ﬁ Click a column heading in a table to sort the information by that property.
Cisco Prime Network 3.9 User Guide
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Links View

Click Show Links View in the toolbar to display the links view in the Prime Network Vision window.

Maps can contain many graphical links, each of which can represent multiple physical, topological,
service, and business links. This can make it difficult for you to view the links you are interested in. In
addition, if the number of graphical links exceeds the number that can be displayed in a map, not all links
are displayed. By using the links view, you can view all links in the map, as well as search for a specific
link and view the status of a link.

Note  You can view and filter the links according to type by using the Link Filter dialog box. For more
information, see Filtering Links in a Map, page 4-38.

Any links that are added or removed from the map are automatically added or removed from the links
view, provided they have not been filtered out.

The links view is selection sensitive; that is, the links displayed in the links view depend on the context
selected in the navigation pane or map. For example, if an aggregation is selected, the links in the
selected aggregation are displayed in the links view.

Figure 2-5 shows a links view.

Figure 2-5 Links View
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Note  An external link has a blue cell background in the table, and you can open the inventory window by
clicking the hyperlink. For more information about external links, see Viewing Link Properties in the
Links View, page 5-8.
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the information that is displayed in the links view.

Table 2-11 Information Displayed in the Links View
Field Name Description
Context Name of the map or aggregation containing the link.

This field can be empty for either of the following reasons:
¢ One side of the link is not included in the map.

e The link is filtered out of all contexts.

Severity

Link alarm severity, represented by an icon. The icon and its color indicate the
alarm severity and thereby the impact of the alarm on the network. For more
information about severity, see Map View, page 2-10.

A End-Point

Element or site that is the source of the link as a hyperlink to the inventory of the
element or site.

Bi Directional

Whether the link is bidirectional or unidirectional: true (bidirectional) or false
(unidirectional). If the link is unidirectional (false), the traffic is from A to Z.

Z End-Point

Element or site that is the destination of the link as a hyperlink to the inventory
of the element or site.

Link Type

Type of link, such as Physical Layer, LAG, MPLS TE Tunnel, pseudowire (PW)
or VPN.

Note Clicking a column heading in the links view sorts the information by that header value.

The links view toolbar includes the tools described in Table 2-9 and the link filtering buttons described

in Table 2-12.

Table 2-12 Link Filtering Buttons

Button Name

Description

@ All Links

Displays the complete list of links for the selected context (map or
aggregation). In other words, the list is not filtered and all the links are
displayed, including external links.

= External Links |Displays links with only one side of the link in this context (map or

aggregation) and the other side either not in the map or outside the selected
context.

Flat Links Displays the links currently visible on the map for the selected context

(map or aggregation), excluding any thumbnails.

Deep Links Displays the links for the current aggregation where both endpoints are

within the currently selected context.

For more information about filtering and sorting links in the links view, see Viewing Link Properties in
the Links View, page 5-8.
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For information about the right-click options available in the links view, see Links View Right-Click
Menu, page 2-45.

Ticket Pane

The ticket pane shows the tickets that relate to the elements in the displayed map. It also contains the
Latest Events tab that shows the latest incoming events for the elements in the map from the time the
map was opened. See Chapter 9, “Working with Tickets in Cisco Prime Network Vision” for more
information.

Prime Network Vision Status Indicators

The following topics describe the ways in which the status of an element is displayed in Prime Network
Vision:

e Severity, page 2-24

e VNE Management State, page 2-25

e Tickets, page 2-29

Severity

Severity indicates the operational health of the element. An element has only one severity value at any
given time, and this value is displayed using a severity color. For more information about the colors used
to display the severity (or propagated severity) of network elements and links, see Alarm Indicators,
page 2-17.

Propagation

Severity is propagated upward in the network hierarchy, displaying the top-most severity of the network
element’s children and thereby ensuring that every single problem in the network is propagated and
visible.

The same severity propagation rules that are used for network elements apply to links. A link is a child
object of an aggregation only if it is fully contained in the aggregation; that is, the network elements on
both sides of the link are part of the aggregation, as shown in Figure 2-6 and Figure 2-7.

Figure 2-6 Link Severity Example 1

1 2

—————
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I
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Figure 2-6 shows critical link 1 between two network elements in an aggregation. This critical link
affects the severity of aggregation 2. That is, the aggregation is critical because it contains a link with a
critical severity. Link severity affects the context.
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Figure 2-7 Link Severity Example 2
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Figure 2-7 shows critical link 1 that forms part of a link aggregation. This affects the severity of link 2
because it contains a link with a critical severity.
New Ticket Propagation

A new ticket indicates a new local fault or accumulates and propagates the number of new faults in its

children. New tickets are propagated upward, displaying the number of new tickets and the top-most
severity.

When new tickets are accumulated, a label is displayed in the navigation pane and map, based on the
following formula:

ns [+]

where:

Symbol |Description

n The number of tickets with the highest severity in the new ticket count.

s The highest severity level in the new tickets:
e C = Critical

e M = Major

e m = Minor

e W = Warning

e N = Normal (cleared alarm)

¢ i = Informational

+ Additional, less severe tickets (optional) exist.

For example:

e An object with three critical new alarms, two major alarms, and one warning alarm is labeled 3C+.

¢ An object with five minor new alarms is labeled Sm.

An icon represents unacknowledged tickets, and the icon color is that of the most severe,

unacknowledged ticket. For more information about severity colors and icons, see Alarm Indicators,
page 2-17.

If all relevant tickets are acknowledged, no bell is displayed.

VNE Management State

The management state indicates the state or mode of the software component (a VNE) managing a
network element and the communication with it. This enables you to determine the accuracy of the
network information and the availability of VNEs to carry out network operations.

Management states are always local indications and are not propagated. A partial exception to this rule
is the propagation of unreachable VNEs.

| oL-26486-01
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The management state indication applies only to VNE and its components. A VNE can have only one
state at a time (for example, Unsupported or Connecting).

A managed VNE icon consists of a managed element icon and one or two overlay icons, or badges:

e The managed element icon displays a symbol of the element, and the color of the symbol indicates
the highest severity ticket that is not cleared for the element.

An element icon is colored green if either of the following is true:
— No ticket of any severity exists for the element.
— All tickets that exist for the element have the severity Cleared or Informational.

For more information about network element icons, see Element Icons, page 2-11. For more
information about severity colors, see Alarm Indicators, page 2-17.

e An alarm badge is displayed on top of a managed element icon, and the color of the alarm badge
indicates the severity of the highest severity ticket that is not acknowledged for the element. If all

tickets are acknowledged, no alarm icon appears.
Figure 2-8 shows an example of an element with the following ticket and alarm severities:
— The highest severity ticket that is not cleared for the element is Major, as indicated by the orange
color applied to the element icon.

— The highest severity alarm that is not acknowledged for the element is Cleared or OK, as
indicated by the green alarm badge.

Figure 2-8 Element with Ticket and Alarm Severity Indicators

5
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1 |Element icon with severity Major (orange)

2 |Alarm badge with severity Cleared or OK (green)

e A VNE management state badge is displayed on top of the managed element icon to indicate the
management state of the VNE in the navigation tree and map. For example, a router that is partially
reachable by Prime Network Vision is displayed as illustrated in Figure 2-9.

Figure 2-9 Element with Overlay Badges
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1 |Alarm badge with severity Warning.

2 |Managed element icon with severity Warning.

3 | VNE management state badge of Device Partially Reachable.
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Table 2-13 and Table 2-14 describe network element communication and investigation states and shows
the related badge for each state.

Table 2-13 VNE Communication States
State Name Description Badge
Agent Not Loaded The VNE is not responding to the gateway because it was stopped, or it was just None

created. This communication state is the equivalent of the Defined Not Started
investigation state.

VNE/Agent Unreachable The VNE is not responding to the gateway. This can happen if the unit or AVM is =
overutilized, the connection between the gateway and unit or AVM was lost, or the
VNE is not responding in a timely fashion. (A VNE in this state does not mean the
device is down; it might still be processing network traffic.)

Connecting The VNE is starting and the initial connection has not yet been made to the device. |None
This is a momentary state. Because the investigation state decorator (the hourglass)
will already be displayed, a special GUI decorator is not required.

Device Partially Reachable |The VNE is not fully reachable because at least one protocol is not operational. Ed

Note  This is the default behavior. You can change the settings that determine when
Cisco Prime Network moves a VNE to Device Unreachable. For more
information, see the Cisco Prime Network 3.9 Administrator Guide.

Device Unreachable The connection between the VNE and the device is down because all of the protocols e
are down (though the device might be sending traps or syslogs).

Note  This is the default behavior. You can change the settings that determine when
Cisco Prime Network moves a VNE to Device Unreachable. For more
information, see the Cisco Prime Network 3.9 Administrator Guide.

Tracking Disabled The reachability detection process is not enabled for any of the protocols used by the |None
VNE. The VNE will not perform reachability tests nor will Cisco Prime Network
generate reachability-related events. In some cases this is desirable; for example,
tracking for Cloud VNEs should be disabled because Cloud VNEs represent
unmanaged network segments.

Because this is a user-defined mode (rather than an error or transitional mode),
Cisco Prime Network does not display a decorator for this state. To troubleshoot a
VNE that is in this state, see the Cisco Prime Network 3.9 Administrator Guide.

Table 2-14 VNE Investigation States
State Name Description Badge
Defined Not Started A new VNE was created (and is starting); or an existing VNE was stopped. In this |None

state, the VNE is managed and is validating support for the device type. (This
investigation state is the equivalent of the Agent Not Loaded communication state.)
A VNE remains in this state until it is started (or restarted).

Unsupported The device type is either not supported by Prime Network or is misconfigured (it is @
using the wrong scheme, or is using reduced polling but the device does not support
it).

To extend Cisco Prime Network functionality so that it recognizes unsupported

devices, use the VNE Customization Builder. See the Cisco Prime Network 3.9
Customization User Guide.

Cisco Prime Network 3.9 User Guide
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Table 2-14 VNE Investigation States (continued)
State Name Description Badge
Discovering The VNE is building the model of the device (the device type was found and is @

supported by Cisco Prime Network). A VNE remains in this state until all device
commands are successfully executed at least once, or until there is a discovery
timeout.

Operational

The VNE has a stable model of the device. Modeling may not be fully complete, but
there is enough information to monitor the device and make its data available to other
applications, such as activation scripts. A VNE remains in this state unless it is
stopped or moved to the maintenance state, or there are device errors.

None

Currently Unsynchronized

The VNE model is inconsistent with the device. This can be due to a variety of
reasons; for a list of these reasons along with troubleshooting tips, see the topic on
troubleshooting VNE investigation state issues in the Cisco Prime Network 3.9
Administrator Guide.

Maintenance

VNE polling was suspended because it was manually moved to this state (by
right-clicking the VNE and choosing Actions > Maintenance). The VNE remains in
this state until it is manually restarted. A VNE in the maintenance state has the
following characteristics:

e Does not poll the device, but handles syslogs and traps.
e Maintains the status of any existing links.
e Does not fail on VNE reachability requests.

e Handles events for correlation flow issues. It does not initiate new service alarms,
but does receive events from adjacent VNEs, such as in the case of a Link Down
alarm.

The VNE is moved to the Stopped state if: it is VNE is moved, the parent AVM is
moved or restarted, the parent unit switches to a standby unit, or the gateway is
restarted.

Partially Discovered

The VNE model is inconsistent with the device because a required device command
failed, even after repeated retries. A common cause of this state is that the device
contains an unsupported module.

To extend Cisco Prime Network functionality so that it recognizes unsupported
modules, use the VNE Customization Builder. See the Cisco Prime Network 3.9
Customization User Guide.

Shutting Down

The VNE has been stopped or deleted by the user, and the VNE is terminating its
connection to the device.

@

Stopped

The VNE process has terminated; it will immediately move to Defined Not Started.

None

More than one management state can occur at the same time. For example, a single overlay icon can be
displayed, reflecting the device status based on the following priorities: Unsupported > Discovering >

VNE/Agent Unreachable > Device Unreachable > Partially Discovered > Operational.

For more information about each of these states and how to troubleshoot any issues, see the Cisco Prime

Network 3.9 Administrator Guide.
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Tickets

Cisco Prime Network Vision displays an icon with a ticket to indicate the severity of the top-most alarm
on the ticket. The icons are the same as those used with network elements (see Table 2-6) and are
displayed in Cisco Prime Network Vision as follows:

Value Navigation Pane Map Ticket Pane
Element with ticket of E—T;jw L Severity | Ticket 1D
Major severity @ v 520030

Prime Network Vision Toolbar

The Prime Network Vision toolbar is context-sensitive and the options vary depending on your selection
in the application.

~

Note  The functionality that a user can access in Prime Network Vision depends on the user role and the

security level of the scopes assigned to the user. For more information, see User Roles Required for
Working with Prime Network Vision Maps, page 4-2.

Table 2-15 identifies the toolbar buttons and describes the functions that are available in the Prime
Network Vision toolbar.

Table 2-15 Prime Network Vision Toolbar
Button Name Function
= . Open Network Opens the Network Elements tab.
= Inventory
Map Options
=5 New Map Creates a new map in the database.
E?’* Open Map Opens a map saved in the database using the Open dialog box.
@ « |Add to Map Adds an element to the map or to the subnetwork selected in the
navigation pane and displayed in the content pane.
H Save Map Saves the current map (the background and the location of devices)
Appearance to the database.

Cisco Prime Network 3.9 User Guide
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Table 2-15

Prime Network Vision Toolbar (continued)

Button

Function

Viewing Options

Show Map View

Displays the map view in the Prime Network Vision content pane
(the button toggles when selected or deselected).

=

Show List View

Displays the list view in the Prime Network Vision content pane (the
button toggles when selected or deselected).

i

Show Links View

Displays the links view in the Prime Network Vision content pane
(the button toggles when selected or deselected).

Overlay Tools

= -

Choose Overlay
Type

Chooses and displays an overlay of a specific type on top of the
elements displayed in the content pane in a map view.

Available overlay options are:
e Ethernet Service
e MPLS-TP Tunnel
e Network Clock

e Pseudowire

e VLAN
e VPLS
e VPN

e None—Removes the existing overlays.

(i

Show Overlay /
Hide Overlay

Displays or hides a previously defined overlay on top of the
elements displayed in the map view.

Note  Overlays do not reflect changes that occur in the selected
service. As a result, the information in an overlay can

become stale.

@

Refresh Overlay

Refreshes the overlay that was last selected.

Viewing Tool

S

2]

Go to Parent

Moves up one level in the navigation pane and content pane so you
can view different information.

Link Filter Opens the Link Filter dialog box, enabling you to display or hide
different types of links in the map and links views.
If a link filter is applied to the map, the Link Filter Applied button
is displayed instead.
Link Filter Applied |Indicates a link filter is currently applied to the map and opens the

Link Filter dialog box so you can remove or modify the existing link
filter.

If no link filter is applied to the map, the Link Filter button is
displayed instead.

] Cisco Prime Network 3.9 User Guide
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Table 2-15 Prime Network Vision Toolbar (continued)
Button Name Function
Overview Opens a window displaying an overview of the network.

Find Business Tag

=]

Opens the Find Business Tag dialog box, enabling you to find and
delete a business tag according to name, key, or type.

Search Tools

Find Previous

[«

Finds the previous instance of the search string entered in the Find
in Map dialog box.

m Find Opens the Find in Map dialog box, enabling you to find an element
in the map by its name or IP address.
Find Next Finds the next instance of the search string entered in the Find in

[»]

Map dialog box.

Map Zoom and Layout Tools

Layout Map

M -

Defines the way in which the elements are arranged in the Prime
Network Vision window: Circular, hierarchical, orthogonal, or
symmetric.

Fit in Window

3

Fits all elements in the map in the content pane.

[:E Normal Selection
Mode

Activates the normal selection mode.

Zoom Selection
Mode

Activates the zoom selection mode, which enables you to zoom in

on a section of the map by clicking and dragging the required area.

Pan Mode

T

Activates the pan mode, which enables you to view different areas
of the map by clicking and dragging the map.

Application-Specific Tools

Open Activation

2

Opens the Activation dialog box.

For more information, see the Cisco Prime Network 3.9
Customization User Guide.

Activation History

=

Opens the Activation History dialog box.

For more information, see the Cisco Prime Network 3.9
Customization User Guide.

Prime Network Vision Menu Bar

The following topics describe the options that are available in each Prime Network Vision menu:

e File Menu, page 2-32
e Edit Menu, page 2-33
e View Menu, page 2-33
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e Node Menu, page 2-34

e Tools Menu, page 2-35

e Activation Menu, page 2-35

e Network Inventory Menu, page 2-36
e Reports Menu, page 2-36

¢ Window Menu, page 2-36

e Help Menu, page 2-37

Note  The functionality that a user can access in Prime Network Vision depends on the user role and the
security level of the scopes assigned to the user. For more information, see User Roles Required for
Working with Prime Network Vision Maps, page 4-2.

Note  The menus are context-sensitive and the options vary depending on your selection in the application.

File Menu

Table 2-16 describes the options that are available in the Prime Network Vision File menu. For more
information, see Chapter 4, “Working with Prime Network Vision Maps.”

Table 2-16 File Menu Options

File Menu Option Description

New Map Creates a new empty map in the database.

Open Map Opens a map saved in the database using the Open dialog box.

Add to Map! Opens the Add dialog box and enables you to add any of the following to the map
or to the subnetwork selected in the navigation pane and displayed in the content
pane:

¢ Cross Connect

e Ethernet Service

e MPLS-TP Tunnel

e Network Element

e Pseudowire

e Unassociated Bridge
e VLAN

e VPLS

e VPN

Save Map' Saves the appearance of the map (the background and the location of devices) to
the database.

Save As Image' Saves the active map as an image and automatically displays the Save as Image
dialog box. Use this dialog box to save an image using a different file format or
name.

Cisco Prime Network 3.9 User Guide
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File Menu Options (continued)

File Menu Option

Description

Print Preview!

Displays how the map will look when it is printed.

Print! Prints the active map as displayed in the Print Preview dialog box.

Load MultiPath Loads a Cisco PathTracer multiple-path trace from a file that was previously
saved in Cisco PathTracer.

Close Closes the selected map or tab.

Exit Exits the Prime Network Vision application and saves the content pane.

1. This option is available only when a map is displayed in the content pane.

Table 2-17 identifies the options available in the Prime Network Vision Edit menu. For more
information, see Chapter 4, “Working with Prime Network Vision Maps.”

Table 2-17

Edit Menu Options

Edit Menu Option

Description

Find in Map

Searches for a device in the map that contains the specified text in the name or
the IP address fields.

Find Business Tag

Searches for business tag information in the database.

Resize This option is displayed only when element icons or aggregations are selected.
Displays the Resize dialog box, enabling you to specify the size of selected icons
or aggregations in the map, either by percentage or size.

Select All Selects all elements in the map.

View Menu
Table 2-18 identifies the options available in the Prime Network Vision View menu. For more
information, see Using the Overview Window, page 4-19.
Table 2-18 View Menu Options
View Menu Option |Description
Layout Defines the way in which the map is displayed in the Prime Network Vision
content pane: Circular, hierarchical, orthogonal, or symmetric.
Overview Opens a window displaying an overview of the network map.
Zoom In Zooms in on the network map.
Zoom Out Zooms out of the network map.
Fit In Window Displays the entire network map in the content pane.
Normal Select Activates the normal selection mode. The selected option is dimmed.
Cisco Prime Network 3.9 User Guide
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Table 2-18 View Menu Options (continued)

View Menu Option |Description

Pan Activates the pan mode, which enables you to move around in a map by clicking
and dragging. The selected option is dimmed.

Zoom Selection Activates the zoom selection mode, which enables you to select an area in a map
to zoom in on by clicking and dragging. The selected option is dimmed.

Node Menu

Table 2-19 describes the Node menu options.

~

Note  Most of the functionality available in this menu is available only when an element icon or an aggregation
is selected in the navigation pane or a map.

Table 2-19 Node Menu Options

Node Menu Option |Description

Inventory Displays a dialog box that enables you to view the physical and logical inventory.
For physical inventory, you can view all the components of the device, such as
modules and ports. In addition, you can view the status of each component. For
logical inventory, you can view all the profiles and virtual channels or routing
tables of the device. For more information, see Chapter 3, “Viewing Network
Element Properties.”

Mark as A Side Starts the process of creating a new static link. This option is enabled when a
device, port, or unmanaged network is selected.

Mark as Z Side Launches the Add Static Link dialog box, enabling you to create a static link
between the two selected nodes. This option is enabled after a device, port, or
unmanaged network is selected and after the Mark as A Side option is selected.

Note If you select two ports, the Add Static Link dialog box is not displayed.

Properties Displays a dialog box enabling you to view the properties of the selected device,
such as the severity, IP address, and communication state. For more information,
see Chapter 3, “Viewing Network Element Properties.”

Cisco Prime Network 3.9 User Guide
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Tools Menu

Table 2-20 describes the Tools menu options.

Table 2-20 Tools Menu Options

Tools Menu Option |Description

Change User Enables you to change the password used when logging into the Prime Network
Password client application suite. The change takes effect the next time you log into the
application.

Note  The administrator can also change a user password in Cisco Prime
Network Administration.

Options Enables you to customize several of Prime Network’s options, such as whether
or not to load the content upon startup. For more information, see Selecting
Prime Network Vision Options, page 2-47.

Change and Config |Displays the Prime Network Change and Configuration Management dashboard.

Mgmnt For more information, see the Cisco Prime Network 3.9 Change and
Configuration Management User and Administration Guide.
Command Jobs Displays all Command Builder jobs that have been scheduled and their details.

For more information, see the Cisco Prime Network 3.9 Customization User
Guide.

Activation Menu

See the Cisco Prime Network 3.9 Customization User Guide for more information about any of the
options in this menu.

Table 2-21 describes the Activation menu options.

Table 2-21 Activation Menu Options

Activation Menu Option Description

Activation Opens the Activation dialog box.

Activation History Opens the Activation History dialog box.

Activation Modification Utility Opens the Activation Modification Utility dialog box.

Cisco Prime Network 3.9 User Guide
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Network Inventory Menu

Table 2-22 describes the Network Inventory menu options.

Table 2-22 Network Inventory Menu Options

Network Inventory
Menu Option Description

Network Elements |Displays a list of the available network elements in the Network Elements tab.
For more information, see Prime Network Vision Inventory Tabs, page 2-5.

Ethernet Flow Displays a list of the current Ethernet flow domains in the Ethernet Flow
Domains Domains tab. For more information, see Viewing and Renaming Ethernet Flow
Domains, page 12-39

VTP Domains Displays a list of the current of the VLAN Trunk Protocol (VTP) domains in the
VTP Domains tab. For more information, see Viewing VLAN Trunk Group
Properties, page 12-65.

Reports Menu

Table 2-23 describes the Reports menu options.

Table 2-23 Reports Menu Options

Reports Menu Option Description

Report Manager Opens the Reports Manager window so you can create, run, and manage
reports.
Run Report Enables you to run standard or user-defined events, inventory, and network

service reports on demand.

For more information about Report Manager and reports, see Chapter 10, “Working with Reports.”

Window Menu

The Prime Network Vision Window menu lists all maps open in the Prime Network Vision content pane,
enabling you to move between the maps. The menu also lists any network element inventory tabs that
are open.

Cisco Prime Network 3.9 User Guide
m. 0L-26486-01 |



| Chapter2 Working with the Cisco Prime Network Vision Client

Help Menu

Prime Network Vision Right-Click Menus 1l

Table 2-24 describes the Help menu options.

Table 2-24 Help Menu Options

Help Menu Option

Description

Cisco Prime
Network Vision
Help

Opens the online help for Prime Network Vision and Prime Network Events.

Icon Reference

Opens a window that identifies and describes the icons and buttons used in Prime
Network Vision and Prime Network Events.

Cisco.com

This option is unavailable.

About Cisco Prime
Network Vision

Displays the Prime Network version and any additionally installed applications.

Prime Network Vision Right-Click Menus

If you right-click a specific area, link, network element, device, or alarm in a Prime Network Vision
window, a context-sensitive right-click menu is displayed that contains options available for the selected

item or items.

Right-click menus are also available in many of the inventory and property windows. For example, if
you right-click an entry in a logical inventory table, you can view properties specific to that entry. The
options that are available depend on the window or table currently displayed and the item selected.

The menus are context-sensitive and the options vary according to your selection in the application. For
example, the right-click menus for network elements and aggregations are different.

Additional right-click options are displayed in the following situations:

e If Prime Network is installed as part of the Cisco Prime suite of applications, right-click menus in
Prime Network Vision include options for accessing the other Cisco Prime applications.

e If Prime Performance Manager is installed in your environment, Prime Network Vision includes
right-click options that allow you to generate device, interface, and VRF-related reports using Prime
Performance Manager.

e The Prime Network Vision installation includes a number of scripts. When these scripts are
installed, they are displayed as options in the right-click menus of the devices that support them. For
more information about these scripts, see the Commands section of the Cisco Prime Network 3.9

Reference Guide.

The functionality that you can access in Prime Network Vision depends on your user role and the security
level of the scopes that you can access. For more information, see User Roles Required for Working with
Prime Network Vision Maps, page 4-2.

See the following topics for the default options available in Prime Network Vision right-click menus:
e Map Right-Click Menu, page 2-38
e FElement Right-Click Menu, page 2-38

e Aggregation Right-Click Menu, page 2-42
e Link Right-Click Menu, page 2-42
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e List View Right-Click Menu, page 2-43
¢ Links View Right-Click Menu, page 2-45
¢ Ticket Right-Click Menu, page 2-46

Map Right-Click Menu

The map right-click menu is displayed when you right-click anywhere on a map in the content pane and
no elements are selected.

Table 2-25 describes the map right-click menu options.

Table 2-25 Map Right-Click Menu Options

Option Description

Go to Parent Moves up one level in the navigation pane and content pane to enable you to view
different information.

Go to Root Moves to the root level in the navigation pane and content pane to enable you to
view different information.

Set Map Displays a background image for the map in the content pane. For more

Background information, see Applying a Background Image, page 4-17.

Element Right-Click Menu

The element right-click menu is displayed when you right-click an element in the navigation pane, the
content pane, or in the Network Elements inventory tab.

)
Note  The element right-click menu is context-sensitive and the options vary depending on your selection in
the application. Also, some options might not be available if multiple elements are selected.

Table 2-26 describes the options available in the element right-click menu.

Table 2-26 Element Right-Click Menu Options

Option Description

Add Associated VLAN |Opens the Add Associated VLAN dialog box so that you can add an
associated VLAN to the selected VLAN. For more information, see Adding
an Associated VLAN, page 12-52.

Aggregate Groups the selected devices into an aggregation in the Prime Network Vision
content pane, and enables you to define a name for the new aggregation. For
more information, see Chapter 4, “Working with Prime Network Vision
Maps.”

Note  You cannot aggregate service entities that exist within services. For
example, you cannot aggregate VRFs that exist in a VLAN.

Cisco Prime Network 3.9 User Guide
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Table 2-26 Element Right-Click Menu Options (continued)

Option

Description

Attach / Detach / Edit
Business Tag

Allows you to perform the following actions:
e Attach a business tag to the selected network element.
e Detach a business tag from a network element.
e Edit a business tag for a network element.
Note The Detach and Edit options are displayed only when a business tag

is attached to a network element.

For more information, see Chapter 6, “Working with Business Tags and
Business Elements.”

Commands

Enables you to launch any of the commands that are included with Prime
Network Vision.

For more information on the available commands and how to implement
them, see the “Using the Prime Network Basic Operation Commands”
chapter in the Cisco Prime Network 3.9 Reference Guide.

Config Mgmnt

This option is available only if Prime Network Change and Configuration
Management is installed.

Displays the Configuration Management page for the selected device in
Prime Network Change and Configuration Management.

For more information, see the Cisco Prime Network 3.9 Change and
Configuration Management User and Administration Guide.

Delete Deletes the selected item from the map.
Disaggregate Ungroups the devices in the selected aggregation in the navigation and map
panes. For more information, see Chapter 4, “Working with Prime Network
Vision Maps.”
Note This option is available only when an aggregation is selected in the
navigation pane or map.
Edit Move the selected virtual router to the location you specify.

Filter Tickets

Displays only those tickets that have the selected VNE as the root cause.

This option is available only for VNEs that have not been deleted by Prime
Network Administration.

Hide Connected
Devices

Hides the devices for sites with one or more connected devices.

Image Mgmnt

This option is available only if Prime Network Change and Configuration
Management is installed.

Displays the Image Management page for the selected device in Prime
Network Change and Configuration Management.

For more information, see the Cisco Prime Network 3.9 Change and
Configuration Management User and Administration Guide.
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Table 2-26 Element Right-Click Menu Options (continued)

Option Description

Inventory Displays a window enabling you to view the physical and logical inventory.
For physical inventory, you can view all the components of the device, such
as the modules, ports, and its IP address or configured VLANS. In addition,
you can view the status of each component. For logical inventory, you can
view all the profiles and VC tables of the device. For more information, see
Chapter 3, “Viewing Network Element Properties.”

Launch external Starts an external application or tool that has been configured for access via
applications the right-click menu. For more information, see the Cisco Prime Network 3.9
Customization User Guide.

Management Contains the following submenu options:

¢ Command Builder—Defines commands and scripts using the Prime
Network Command Builder tool (Configurator security level required).

e Soft Properties Management—Extends VNEs by adding SNMP MIB or
Telnet/SHH/TL-1 properties to the device’s collected information model
using the Prime Network Soft Properties Manager (Administrator
security level required).

For more information about Command Builder and Soft Properties Manager,
see the Cisco Prime Network 3.9 Customization User Guide.

Modify Displays the Modify dialog box so that you can change the selected item’s
name, description, or icon.

Open Relevant Maps Displays the Open Map dialog box so that you can view and open maps that
contain the selected element.

PathTracer Launches a path trace from the selected item.
Poll Now Polls the selected element.
Properties Displays the properties of the selected item, such as the IP address and

system name. In addition, you can open the VNE Properties dialog box and
manage VNE properties. For more information, see Chapter 3, “Viewing
Network Element Properties.”

Remove from Map Removes the selected device and all its children from the map (navigation
pane and content pane). The device that has been removed is still maintained
in the network.

Rename Renames the selected item.
Resize Enables you to resize an object on the map by percentage or size.
Run Report Enables you to run standard or user-defined events, inventory, and network

service reports on demand.

Save as New Map Creates a new map and places the selected aggregation as the root, while
leaving the original map intact.

Script names Launches available activation and configuration scripts. This can include the
commands documented in Commands part of the Cisco Prime Network 3.9
Reference Guide, and those you create using Command Builder (can be
launched against multiple network elements). For more information, see the
Cisco Prime Network 3.9 Customization User Guide.
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Table 2-26 Element Right-Click Menu Options (continued)

Option

Description

Show as Aggregation /
Thumbnail

Displays the selected aggregation as a single entity or as a collection of
items.

The options toggle, depending on whether the aggregation is in a thumbnail
or aggregated view.

Show CE Device

Displays devices for sites or LCPs with one or more hidden, connected
devices.

Tools The Tools option contains the following choices:
e CPU Usage—Displays memory and CPU usage information for a device
or network element.
e Ping—Pings the device from the client station.
e Telnet—Communicates with the device using the Telnet window from
the client station.
Note If you are using a Windows 7 system and want to use the Prime
Network Telnet option, you need to set up Telnet on the Windows 7
system as follows:
- For Windows 7 32-bit systems, enable the Windows Telnet Client
to use the Prime Network Telnet option.
- For Windows 7 64-bit systems, a solution is available on the
Cisco Developer Network at
http://developer.cisco.com/web/ana/forums/-/message_boards/mess
age/2780108.
Topology The Topology option enables you to add:
e A static link between two devices.
e A static topology between a device and an unmanaged network.
e A tunnel to a VPN.
When working with static links, the following submenu options enable you
to define the A Side and Z Side of the link:
e Mark as A Side
e Mark as Z Side
When working with VPNs in VPN Service View, the Add Tunnel submenu
option allows you define and configure tunnels.
VNE Tools Contains the following submenu options:

e Poll Now—Updates the VNE information.
e Stop VNE—Stops the VNE.
e Start VNE—Starts the VNE.

For more information, see Chapter 3, “Viewing Network Element
Properties.”
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Aggregation Right-Click Menu

The aggregation right-click menu is displayed when you right-click an aggregation in a map.

Table 2-27 describes the aggregation right-click menu options.

Table 2-27 Aggregation Right-Click Menu Options

Option Description

Aggregate Groups the selected aggregations into an aggregation in the Prime Network
Vision content pane, and enables you to define a name for the new aggregation.
For more information, see Chapter 4, “Working with Prime Network Vision
Maps.”

Disaggregate Ungroups the selected aggregation in the navigation pane and map in the Prime
Network Vision window. All the aggregations in the selected node move up one
level, and the original aggregation is removed. For more information, see
Chapter 4, “Working with Prime Network Vision Maps.”

Rename Renames the selected aggregation.

Resize Defines the size of selected aggregations in a map according to one of four sizes
or according to a percentage of the current size.

Remove from Map |Removes the selected aggregation and all its children from the navigation pane
and the map.

Save as New Map |Creates a new map and places the selected aggregation as the root, while leaving
the original map intact.

Run Report Enables you to run standard or user-defined events, inventory, and network
service reports.
Show as Displays the aggregation as a single entity or as a collection of items.
Aggregation / . . L .
) The options toggle, depending on whether the aggregation is in a thumbnail or
Thumbnail

aggregated view.

Delete Deletes the selected item.

This option is available when the item is marked with the reconciliation icon.

Link Right-Click Menu

The Link right-click menu is displayed when you right-click a link in the map view. For more
information, see Chapter 5, “Working with Links.”

Table 2-28 describes the link right-click menu options.

Table 2-28 Link Right-Click Menu Option

Option Description

Properties Displays the properties of the selected link.
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The list view right-click menu is displayed when you right-click an entry in the Network Elements tab
in the list view table. For more information, see List View, page 2-18.

Table 2-29 describes the list view right-click menu options.

Table 2-29 List View Right-Click Menu Options - Network Elements Tab

Option

Description

Inventory

Displays a window enabling you to view the physical and logical inventory.
For physical inventory, you can view all the components of the device, such
as the modules, ports, and its IP address or configured VLANS. In addition,
you can view the status of each component. For logical inventory, you can
view all the profiles and VC tables of the device. For more information, see
Chapter 3, “Viewing Network Element Properties.”

Attach / Detach /
Edit Business Tag

Allows you to perform the following actions:
e Attach a business tag to the selected element.
e Remove a business tag from the selected element.
e Edit an existing business tag for the selected element.
Note The Detach and Edit options are available only when a business tag

is attached to a link.

For more information, see Chapter 6, “Working with Business Tags and
Business Elements.”

Config Mgmnt

Displays the Configuration Management page for the selected device in
Prime Network Change and Configuration Management.

For more information, see the Cisco Prime Network 3.9 Change and
Configuration Management User and Administration Guide.

Image Mgmnt

Displays the Image Management page for the selected device in Prime
Network Change and Configuration Management.

For more information, see the Cisco Prime Network 3.9 Change and
Configuration Management User and Administration Guide.

Run Report

Enables you to run standard or user-defined events, inventory, and network
service reports.

Show Only
Selected Rows

Displays only the rows that you select.

For more information, see Viewing Selected Rows, page 2-54.

Show All Rows

Displays all table rows that meet the current filtering criteria.

| oL-26486-01

Cisco Prime Network 3.9 User Guide ]


http://www.cisco.com/en/US/products/ps11879/products_user_guide_list.html
http://www.cisco.com/en/US/products/ps11879/products_user_guide_list.html
http://www.cisco.com/en/US/products/ps11879/products_user_guide_list.html
http://www.cisco.com/en/US/products/ps11879/products_user_guide_list.html

Chapter2  Working with the Cisco Prime Network Vision Client |

M Prime Network Vision Right-Click Menus

Table 2-29 List View Right-Click Menu Options - Network Elements Tab (continued)

Option

Description

Tools

Contains the following submenu options:

e CPU Usage—Displays memory and CPU usage information for a device
or network element.

e Ping—Pings the device from the client station.

e Telnet—Communicates with the device using the Telnet window from
the client station.

Note If you are using a Windows 7 system and want to use the Prime
Network Telnet option, you need to set up Telnet on the Windows 7
system as follows:

- For Windows 7 32-bit systems, enable the Windows Telnet Client
to use the Prime Network Telnet option.

- For Windows 7 64-bit systems, a solution is available on the
Cisco Developer Network at
http://developer.cisco.com/web/ana/forums/-/message_boards/mess
age/2780108.

Topology

Enables you to add:
e A static link between two devices.
e A static topology between a device and an unmanaged network.
e A tunnel to a VPN.

When working with static links, the following submenu options enable you
to define the A Side and Z Side of the link:

e Mark as A Side
e Mark as Z Side

When working with VPNs in VPN Service View, the Add Tunnel submenu
option allows you define and configure tunnels.

Launch external
applications

Launches external applications or tools, such as an SSH client. See the
Cisco Prime Network 3.9 Customization User Guide.

Properties

Displays the properties of the selected item, such as the IP address and
system name. In addition, you can open the VNE Properties dialog box and
manage VNE properties. For more information, see Chapter 3, “Viewing
Network Element Properties.”

Commands

Enables you to launch any of the commands that are included with Prime
Network Vision. For a complete list of the available commands, see the
Cisco Prime Network 3.9 Reference Guide.

Script names

Launches available activation and configuration scripts. This can include the
commands documented in Commands part of the Cisco Prime Network 3.9
Reference Guide, and those you create using Command Builder (can be
launched against multiple network elements). For more information, see the
Cisco Prime Network 3.9 Customization User Guide.
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List View Right-Click Menu Options - Network Elements Tab (continued)

Option

Description

Management

Contains the following submenu options:

e Command Builder—Defines commands and scripts using the Prime
Network Command Builder tool (Configurator security level required).

e Soft Properties Management—Extends VNEs by adding SNMP MIB or
Telnet/SHH/TL-1 properties to the device’s collected information model
using the Prime Network Soft Properties Manager (Administrator
security level required).

For more information about Command Builder and Soft Properties Manager,
see the Cisco Prime Network 3.9 Customization User Guide.

VNE Tools

Contains the following submenu options:
e Poll Now—Updates the VNE information.
e Stop VNE—Stops the VNE.
e Start VNE—Starts the VNE.

For more information, see Chapter 3, “Viewing Network Element
Properties.”

Links View Right-Click Menu

The links view right-click menu is displayed when you right-click a link in the links view table. For more
information, see Chapter 5, “Working with Links.”

Table 2-30 describes the links view right-click menu options.

Table 2-30

Links View Right-Click Menu Options

Option

Description

Attach Business
Tag

Attaches a business tag to the selected link. For more information, see Chapter 6,
“Working with Business Tags and Business Elements.”

Detach/Edit
Business Tag

Detaches or edits a business tag from the selected link. For more information, see
Chapter 6, “Working with Business Tags and Business Elements.”

The Detach and Edit options are available only when a business tag is attached
to a link.

Select Link in Map

Highlights the selected link in the content pane.

Show Only
Selected Rows

Displays only the rows that you select.

For more information, see Viewing Selected Rows, page 2-54.

Show All Rows

Displays all table rows that meet the current filtering criteria.

Properties

Displays the properties of the selected link.
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Ticket Right-Click Menu

The Ticket right-click menu is displayed when you right-click a ticket in the ticket pane. The Ticket
right-click menu enables you to view ticket properties and highlights the links or elements that are
affected by a ticket. The Ticket menu also enables you to acknowledge, clear, and remove a ticket. For
more information, see Chapter 9, “Working with Tickets in Cisco Prime Network Vision.”

Table 2-31 describes the ticket right-click menu options.

Table 2-31 Ticket Right-Click Menu Options

Option Description

Acknowledge Acknowledges that the ticket is being handled; the ticket is displayed as true in
the ticket pane. Acknowledging an alarm removes the alarm icon from the device
icon. Multiple tickets can be acknowledged at the same time.

Clear Approves the reported faulty ticket and clears the faulty networking entity from
Prime Network. The ticket is displayed as Clear in the ticket pane.
Note  When a Card Out or Link Down alarm occurs, the relevant information is

displayed in the inventory and maintained in the VNE.
Remove Removes the ticket and all its active subtickets from the ticket pane (this option

is only available after the ticket has been cleared). The deleted tickets can be
viewed using Cisco Prime Network Events. Multiple tickets can be removed at
the same time.

Note  When a ticket is removed, the information is no longer displayed in the

inventory and is removed from the VNE.

Clear and Remove

Approves the reported faulty ticket and clears the faulty networking entity from
Prime Network. In addition, the ticket and all its active subtickets are removed
from the ticket pane.

Find Affected Finds any elements affected by the selected ticket:
Elements e Ifonly one element is affected, it is selected in the Prime Network navigation
pane and content area.
e If multiple elements are affected, they are displayed in the Affected
Elements window.
Show Only Displays only the rows that you select.

Selected Rows

For more information, see Viewing Selected Rows, page 2-54.

Show All Rows

Displays all table rows that meet the current filtering criteria.

Properties

Displays the Ticket Properties dialog box, enabling you to view ticket
information, including impact analysis details of the affected parties and
correlated alarms. See Viewing Ticket Properties, page 9-10.
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Changing a User Password in Prime Network Vision

Changing a User Password in Prime Network Vision

Step 1

Step 2

Step 3

Prime Network enables you to provide authentication by Prime Network or an external Lightweight
Directory Access Protocol (LDAP) server. The method used to change your password depends on
whether authentication is provided by Prime Network or an LDAP server:

e If Prime Network provides login authentication, Prime Network Vision enables you to change your
login password. If needed, the administrator can also change your password in Cisco Prime Network
Administration.

e If Prime Network uses an LDAP server for authentication, you cannot change your password in
Prime Network Vision. Only users with Administrator privileges can change your password, which
must be done on the LDAP server.

— For more information about external authentication, see the Cisco Prime Network 3.9
Customization User Guide.

— For more information about password guidelines, see the Cisco Prime Network 3.9
Administrator Guide.

To change your password:

Choose Tools > Change User Password. The Change User Password dialog box is displayed.

~

Note  If Prime Network uses an LDAP server for authentication, the Change User Password option is
dimmed. Contact your administrator to change your password on the LDAP server.

Enter the following information:
e 0Old password—Enter the old user password.
e New password—Enter the new user password.
¢ Confirm password—Enter the new password again to confirm the entry.

Click OK. The change takes effect the next time you log into the application.

Selecting Prime Network Vision Options

Step 1
Step 2

Prime Network Vision enables you to select map, display, audio, event history size options.

To select Prime Network Vision options:

Choose Tools > Options from the main menu.

In the Startup tab, check the Load Workspace on Startup check box to automatically view the content
pane when you log in. Uncheck the check box if you do not want to view the content pane when you log
in.
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Step3  Click the Display tab. Set the display options using the information in Table 2-32.

Table 2-32 Prime Network Vision Display Options

Field Description

Preferences

Map Labels Font Size In the drop-down list, choose the preferred font size for labels on maps.
Font sizes are 26, 28, 30, 32, and 34, with a default of 30.

Severity

Show Severity Text Check the check box to view severity labels in the navigation pane and
(e.g. [3M+] maps, using the formula described in New Ticket Propagation,
page 2-25.

Uncheck the check box to hide severity labels.

Show Acknowledged Check the check box to view the number of both acknowledged and
unacknowledged alarms in the network element display name.

Uncheck the check box to view only the number of unacknowledged
alarms in the network element display name.

For example, assume that device NE1 has two alarms with the severity
M. One of these two alarms is acknowledged, and the other is not. If
you check the Show Acknowledged check box, the display name will
be NE1 [2M]. If you uncheck the Show Acknowledged check box, the
display name will be NE1 [I1M].

Show Propagated Check the check box to view propagated alarms on the specific entity.

Uncheck the check box to view only the alarms on the specific entity.

Display Name

Display Name Select the preferred setting for network element names:

¢ Do not use Business Tag—Displays the original network element
name only.

e Add Business Tag to name—Displays the original network element
name and the name of the business tag.

e Replace name with Business Tag—Replaces the network element
name with the business tag name. When a subscriber is attached to
a port, the subscriber name is also added.

Step4  Click the Audio tab and select your preferences for audio notifications using the information in
Table 2-33.

Cisco Prime Network 3.9 User Guide
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Prime Network Vision Audio Options
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Field

Description

Enable Audio Response for Alarm

Select the preferred setting for audio notifications:

¢ To indicate that a sound is to be issued when an alarm is
triggered, check the check box.

e To prevent a sound from being issued when an alarm is
triggered, uncheck the check box.

If you uncheck the check box, continue with Step 6.

Critical Specify the .wav file to use for critical alarms.
Major Specify the .wav file to use for major alarms.
Minor Specify the .wav file to use for minor alarms.

Loop Sound on Critical Alarm

Specify whether or not the critical alarm sound should sound
continuously when a critical alarm is triggered:

e To play the critical alarm sound continuously when a
critical alarm is triggered, check the check box.

e To play the critical alarm sound only once when a critical
alarm is triggered, uncheck the check box.

Step 5 Click the Events tab and, in the Events History Size in Hours field, enter the length of time in hours that
Cisco Prime Network Vision should use when determining the events to display in the Network Events
and Provisioning Events tab in the inventory window (see Ticket and Events Pane, page 3-18). If you
enter a value of 0 (zero), only active events are displayed in the Network Events tab in inventory. The
default value of six hours can be changed in Prime Network Administration.

Step6  Click Apply to apply your selections.
Step7  Click OK.

Working with Prime Network Tables

Prime Network uses tables to display different types of information. The following topics describe how
to work with Prime Network tables so that you can view the information that you want and, optionally,
save the information to a file:

Table Toolbar Options, page 2-50
Finding Text in a Table, page 2-51
Sorting a Table, page 2-51

Filtering Table Contents, page 2-53
Viewing Selected Rows, page 2-54
Exporting Tables to a File, page 2-55
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To view all text in a table cell, you can do either of the following:
¢ Click the red triangle in the cell to automatically expand the cell to the size of the cell’s contents.

e Hover your mouse cursor over the cell.

Table Toolbar Options

Table 2-34 describes the options available in table toolbars.

Table 2-34 Table Toolbar Options
Option Name Description
Find : Find Searches the current table for the string you enter.
For more information, see Finding Text in a Table,
page 2-51.
@ Export to CSV Exports the information displayed in the table, or

selected portions, to a CSV file.

For more information, see Exporting Tables to a
File, page 2-55

4l Sort Table Values Sorts the information displayed in the table by the
criteria you specify.

For more information, see Sorting a Table,

page 2-51.
Filter Filters the information displayed in the table by the

v criteria you specify.
For more information, see Filtering Table Contents,
page 2-53.

!7 Clear Filter Clears the existing filter.

ﬁ Show All Rows Displays all table rows that meet the current filtering
criteria.

ﬁ' Show Only Selected |Displays only the rows that you select.

Rows . . .
For more information, see Viewing Selected Rows,

page 2-54.
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Using Keyboard Shortcuts in Tables

Table 2-35 lists the keyboard shortcuts that you can use when working with tables.

Table 2-35

Keyboard Shortcuts for Tables

Keyboard Shortcut

Description

Ctrl + A

Selects all the rows in the table.

Ctrl + Space

Deselects all the rows in the table.

Enter

On a selected row, opens the default action.

Arrow Navigation Keys

Navigates up and down in the rows.

Ctrl + Up/Down

Keeps the selected row and moves up or down.

Ctrl + Up/Down + Space

Keeps the selected row and moves up or down. The space selects
the required row.

Shift + Up/Down

Keeps the selected row and selects all the rows that are above or
below it.

Shift + F10 Opens the right-click menu.
F3 Finds next.
Shift + F3 Finds previous.

Finding Text in a Table

Step 1

Step 2

Prime Network Vision enables you to search for information about a specific entry in a table by entering
search criteria, such as a partial IP address.

To find text in a table:

In the Find field on the toolbar, enter the search criterion for the entity that you want to find and press

Enter.

Press F3 to continue searching the table or press Ctrl + F to return to the Find field.

Sorting a Table

Prime Network Vision enables you to sort a table in the following ways:

e According to a column, by clicking the required column heading.

e In ascending or descending order, by clicking a column heading.

e By clicking Sort Table Values in the toolbar and specifying sort criteria.

A triangle next in the column heading indicates the sort order:

- . . . .
. indicates the column is sorted in ascending order.

N L. . . .
. indicates the column is sorted in descending order.
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To sort a table using the Sort Table Values option:

Step 1 In the table toolbar, click Sort Table Values. The Sort dialog box is displayed.

Figure 2-10 Sort Dialog Box

Sort X

Sort Dperation

Once Only  (8) Continuoushy/Repeatedhy

Sork By | Pzeudowire Type hd | | Ascending - | |T| |T|
Then By | Description v | | Ascending | (-]+]
Then By [ Name v | [Ascendng_ ][ ][ +]

Ok | Cancel |

310523

Step2  In the Sort Operation field, specify the frequency of the sort operation:

¢ Only Once—Sorts the information in the table only once according to the specified criteria. When
this option is selected, newly added rows will always be listed at the bottom of the table, regardless
of their sort criteria value. Also, if an existing row's value changes, the row will remain where it is.

¢ Continuously/Repeatedly—Sorts the information in the table continuously according to the
specified criteria.

If you select this option, the ®

icon is displayed next to the selected column heading.
Step3  In the Sort By field, specify the first sort criterion:
a. In the first drop-down list, choose the column to use for the first sort criterion.

b. In the second drop-down list, choose Ascending or Descending to indicate the sort order.

Step 4 If needed, click| * ‘to add another sort criterion.

Step5  Adjust the sort criteria as needed:

e To add additional criteria, click| * ‘.

e To remove a criterion, click‘ =,

Step6  Click OK to sort the table using the specified criteria.

Cisco Prime Network 3.9 User Guide
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Filtering Table Contents

You can view only those items that are of interest to you by filtering a table’s contents. This feature can
be extremely helpful when working with tables that contain many entries.

~
Note If you load a table with many entries, (for example, thousands of entries), it can take a while for the

complete table to load. The filtering options in the table toolbar are unavailable until the table has
completely loaded.

The following changes in the GUI indicate that a filter has been applied:
e The Filter button is slightly shaded.
e The Clear Filter button is active.
e The filter details are displayed:
— In the status line below the table.
— When you hover the mouse cursor over the Filter button.

To define a filter:

Step1  In the toolbar above the table, click Filter. The Filter dialog box is displayed as shown in Figure 2-11.

Figure 2-11 Table Filter Dialog Box
Filter X
Makch of the Following rules @
| Context - | [ Contains - &
(a4 | Cancel | Clear

236844

Step2  In the Match drop-down list, choose the rule for including items that meet the specified criteria:
¢ All—AIl of the following criteria are to be met.
¢ Any—Any of the following criteria are to be met.

Step3  For each criterion, specify the following information:

a. In the first drop-down list, choose the primary match category. The drop-down list contains all
columns in the current table.

b. In the second drop-down list, choose the rule to use for this criterion. The options are:
— Contains
— Does not contain
— Equals
— Does not equal
— Greater than

— Less than

Cisco Prime Network 3.9 User Guide
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Step 4

Step 5
Step 6

Step 7

¢. The third field either lists the available values or allows you to enter text:
— If a drop-down list is displayed, choose the required entry.
— If an entry field is displayed, enter a string or regular expression for the criterion.

Any entry that is not a regular expression is treated as a string.

Je

Tip You can use the “Greater than” or “Less than” rule with a string for filtering. For example, if you
want to include all interfaces above Ethernet0/0/3, you can select Greater than and enter the
string Ethernet0/0/3 to view interfaces Ethernet0/0/4, Ethernet0/0/5, and so on.

Click “™ to add another criterion for this filter.

Add additional criteria as required. To remove a criterion, click * <
When you have specified all criteria for the filter, click OK.

The table data is displayed using the defined filter.

To clear a filter, click Clear Filter in the table toolbar.

The table is refreshed and all entries are displayed.

The following tables have additional filtering capabilities:

e Prime Network Vision ticket pane. For more information, see Filtering Tickets by Criteria, page 9-8.

e Links view in the content pane. For more information, see Links View, page 2-22.

Viewing Selected Rows

Prime Network enables you to select a line or a specific set of lines, and display them in the table. The
lines that you do not select are hidden from view.

You can use this feature with the filtering mechanism to view the specific entries that you need. You can
either select specific rows and then apply a filter, or you can filter the table’s contents and then select
specific rows to view.

If you apply a filter, the details of the filter are displayed below the table. For example, if you apply a
filter that specifies all elements with names containing ME are to be displayed, the following appears in
the table status line:

Filter: Name Contains ME

The status bar below the table also displays the:
e Number of the selected row, if a row is selected.
e Number of rows selected, if any.
e Total number of rows currently displayed in the table.
For example, if you select line four in a table with six rows, the following information is displayed:

Line 4 (1/6 Selected)

Cisco Prime Network 3.9 User Guide
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If no rows are selected, the value for the line defaults to O, such as:

Line 0 (Size 6)

To view selected rows:

Select the appropriate line or lines in the table using standard Windows mouse or keystroke operations.
Click Show Only Selected Rows.
The table displays the selected rows, and the Show All Rows option becomes active.

Click Show All Rows to view all rows in the table.

Exporting Tables to a File

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6

Prime Network Vision enables you to export the currently displayed data from a table. You can either
select specific rows to export, or clear all selections in the table to export the entire table. The data can
then be imported and viewed at a later stage.

To export a table to a file:

Press Ctrl + Space to clear any existing selection.
Identify the content you want to export:
e To export specific rows, select the required rows.
e To export the entire table, ensure that nothing is selected.
In the table toolbar, click Export to CSV. The Export Table to File dialog box is displayed.
Navigate to the directory where you want to save the table.
In the File name field, enter a name for the file.

Click Save. The content specified in Step 2 is saved in the specified file and directory.
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